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Assembly Instructions
Assemble your educational robot and start your Robotic journey 

MC4.0 is the world’s most ingenious Multi-coding robotics AIoT kit for every student 

from school to university to learn all STEM concept (Science, Technology, Engineering, 

Mathematic) and experience the charm of mechanics, electronics, control system and 

1 2Start!
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Fixing Brass Studs

Fix the brass studs on the chassis using
M4x8 screws

    

· brass Studs     4Pcs

· Chassis         1Pcs
· M4x8            4Pcs    

Brass Studs Fixed

This step should be the first one before 
Install the motors

The Motors Installing

Attach the motors with the chassis with M3x25 screws
and hold the screws with M3 nuts

    

· M3 nuts               4Pcs

· DC Encoder Motors     4Pcs
· M3x25                 4Pcs    

This is a bottom view of the correct way to 
position the Motors

Motor Installed View

computer science. 

 

Scan for Assembly
Video
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Motor Shaft Coupling 

Fix the motor shaft coupling whit wheels 

The Wheels Orientation

The directions of the wheels shall be installed in
 the following orientation so that the diagonal 

    

· Motor shaft           4Pcs 

· DC Encoder Motors     4Pcs
· Wheels                4Pcs    

directions are the same or closed a V-shape 
from the frontside and the backside

· Wheels                4Pcs
· Motor shaft           4Pcs    

Wheels Fixing

Attach the wheels to the motors shaft using M3x30

    

· Motor shaft           4Pcs 

· DC Encoder Motors     4Pcs
· Wheels                4Pcs    

· M3x30                 4Pcs    

MC4.0 Controller

Stack the  controller with the DC encoder MC4.0

    

· Battery base module   1Pcs 

·  controller      1PcsMC4.0
· DC encoder module     1Pcs    

module and Battery base module
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Ultrasonic sensor

Fix the ultrasonic sensor in the front of the  

· Ultrasonic sensor     1Pcs
· M4x10                 2Pcs    

chassis using M4x10 screws 

Line Follower sensor

Place the line follower sensor in the bottom of the

· Line follower sensor  1Pcs
· M4x8                  2Pcs    

chassis using M4x8 screws 

Lithium Battery

Put the lithium battery on the ADD-on fixture

· Lithium battery       1Pcs
· Add-on fixture         1Pcs    

at the two holes in the middle

MC4.0 control unit

Attach the  controller unit on the chassisMC4.0

·  control unit    1PcsMC4.0
· M3x25 screws          4Pcs    

using M3x25 screws 
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Fixture Add-on

Put the add-on fixture on the brass studs

· Chassis group         1Pcs
· Add-on fixture group   1Pcs    

using M4x8 screws

· M4x8 screws           2Pcs    

Let It Go!

Lithium Battery

Hold the lithium battery on the ADD-on fixture

· Lithium battery       1Pcs
· Add-on fixture         1Pcs    

using M4x8 screws

· M4x8 screws           2Pcs    



Start!

Motors Wiring

Connect the motors wires to the DC encoder module with the  

· FL =    Forward  Left  Motor
· BL =    Backward Left  Motor    
· FR =    Forward  Right Motor
· BR =    Backward Right Motor    

1

white connectors

2

Motors Wiring

The wires are bent from the bottom and hidden
in the chassis in this way

3

Ultrasonic & Line-Follower Wiring

The wires are connected to both ports B and C

· PortC = Ultrasonic   Sensor
· PortD = Line-Follwer Sensor

Line-Follower UltraSonic

Let's wire up your robot and bring it to life!

Whether you're a beginner or an advanced learner,  offers a comprehensive set of wiring instructions to help you MC4.0
understand the principles of electronics and control systems.

END



Get Started
Ready to unleash the full potential of your MC4.0 kit

Let's get started with your  kit! In this section, we'll guide you through the steps to operate your robot and connectMC4.0
it to the Wi-Fi network, so you can start exploring the world of robotics and AIoT.

1Start!

2

Connect Method

MC4.0 offers two programming options: cable-based and wireless over the internet. Both firmware 

versions have the same features, but the web version has the added benefit of wireless communication 

and IoT capabilities. While the web-based and offline IDEs may appear similar, there is one key 

difference: to use the web IDE, you need to connect MC4.0 to a Wi-Fi network first, and use the device

API key to pair it with the web IDE.

WiFi Config

1. Short press the power button on the left side of the MC4.0 for 2 seconds to turn on, and the Maker and Coder 
Logo appears on the screen. After entering the main page, press the "Setup" button on the screen

Connect to the WiFi

Connect to

UiFlow

Platform

Pair with API key

Type-C USB cable

2. In the Wi-Fi option, press the start button of the config Wi-Fi by web option, and the device will automatically 
restart.

Power ON

Press Setup Press Start After auto restart
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WiFi Connection

3. Once the device is up and running, you'll see the WiFi 

Config page. Simply find the device SSID hotspot name, and 

jump to your mobile phone, Tablet, iPad, or computer's WiFi  

settings,and connect to it to proceed.

WiFi Setup

Pairing with UiFlow

5. Open your browser, enter the URL flow.m5stack.com and use the API KEY shown on the device, and from the 

devices menu, chose Core2 Device

Device SSID

4. 192.168.4.1 Open the browser to access , and 

enter the WiFi information in the pop-up page 

to configure it successfully Network distribution 

(note: special characters such as "space" are not 

allowed in WiFi information). After the 

configuration is successful, the device will 

automatically restart. And enter the online 

programming mode.

UiFlow

API KEY:

XXMC40XX

Open your browser, ener the URL
flow.m5stack.com, and use this
API KEY to start  now!UiFlow

use API key and connect to

UiFlow Platform
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USB Cable Connection

When programming with the offline version of UIFlow, you need to configure the device to USB mode.

installing UiFlow IDE

To install the UiFlow IDE on your device, scan the QR code and open the link in your web browser. Then, choose 

the suitable operating system and click on the 'Install' button to proceed. Once the installation is complete, open 

the IDE and remember to select the correct COM port and device before programming your MC4.0 kit.

1.   Short press the power button for 2s to start the device

2.   After the menu appears on the screen, quickly click the UIFlow option.

3.   Select the USB mode.

4.   Select the corresponding port in the configuration box of UIFlow Desktop IDE, and the programming device, 

      click OK to connect.

Power ON

Press Flow choose USB After auto restart

END



Block-based programming with UiFlow is designed to be easy and simple, even for beginners. In this section, we'll show you 
how to use UiFlow to create code for your MC4.0 kit in a fun and interactive way. With a visual interface similar to Scratch, 
UiFlow makes it easy for anyone to start programming and bring their ideas to life.

Block-Based programming
Discover the simplicity of block-based programming with UiFlow!

1 Hello world - Displaying text and pictures 

“Hello world” has long been held as the induction to programming, regardless of what language

is being taught. It teaches the most basic of programming concepts and prints "Hello World" to 

the screen of the device. While it may sound simple, even some seasoned programmers may use 

this code as a test when trying a new language or device for the first time. Once we have learned 

the hello world program it will give us the confidence to go on to learn more advanced things.

So let’s get started with our “Hello world” program

1
Start by dragging a label 

on to the UI Manager from 

the left panel.

2
a pop-up message will appear 

to let you set all the feature

of the label, you can change the

color, text, font, and others

Hello World



Click on the UI section of the blocks menu and you'll notice there is a sub-menu entitled "label" Inside the label we'll find a bunch 

of different blocks which can be used to program the text label. We will choose the first in the list for now "Label (label_name) 

show [text] Drag this block into the coding area and connect it up to the setup block. Now we can enter "hello world" inside the 

text field, or any other message for that matter of fact.

Hello world - Displaying text and pictures MC4.0 Manual - Block-Based programming  

3 Click on the label blocks - 

select label show block

4 Drag it into the coding 

area and connect it to the 

setup block

5 change the text

to “Hello World“

Now you've created your very first program. That was easy, wasn't it? Now in order for it to run on the MC4.0 we need to make 

sure that your WiFi setup is done, or your USB cable is connected and that you have entered into USB mode as instructed 

explained earlier.

If your MC4.0 Device is connected properly 

you should notice The word "connected" in green.

If you don't see it click on the refresh Icon 

next to it to try to reconnect.

Click on the play button at the bottom 

right-hand corner of the window to run 

your program



Adding images to your MC4.0 screen is a breeze with UiFlow. Simply drag and drop the 'Image' object from the left menu to your 

desired location on the screen. From the pop-up message, you can easily upload your image. Be sure to keep your image size under 

50KB and its dimensions no larger than 320x240 pixels to ensure optimal display.

Hello world - Displaying text and pictures MC4.0 Manual - Block-Based programming  

Now you've created your very first program. That was easy, wasn't it? Now in order for it to run on the MC4.0 we need to make 

sure that your WiFi setup is done, or your USB cable is connected and that you have entered into USB mode as instructed 

explained earlier.

1 Start by dragging a Image

on to the UI Manager from 

the left panel.

2 Set your image position 3 Upload the image 

Once you've uploaded your image, be sure to select it from the list of uploaded images in the pop-up message. The selected image

 will be displayed on both the UiFlow screen and your MC4.0 device's screen

4

After, Select the uploaded image

and once selected it’ll be shown 

on the MC4.0 screen



Get ready to add some color to your MC4.0 project! In this next example, we'll explore the RGB bar located at the bottom of MC4.0 

With UiFlow, you can easily adjust the RGB values to create your own custom colors and make your project pop. Let's dive in!

RGB Color MC4.0 Manual - Block-Based programming  

2 RGB Color

So let’s get 

1 Start by dragging a label on to the 

UI Manager from the left panel and 

change the text to RGB Color. 2 Drag three Sliders to the UI Manager

Adjusting the length of the sliders changes the intensity of each color, allowing you to create a wide range of colors. Keep in mind 

that the maximum value for each color is 255, so adjusting the sliders to the desired length within that range will give you the 

best results. 3 By clicking on the Slider the pop-up window will appear and 

you can change the position, width, and Max value as shown



To make things even easier, we can label the sliders with the letters R, G, and B to correspond with 

each color channel. With these labels in place, we can easily add the necessary blocks to control the 

RGB LED on the MC4.0.

RGB Color MC4.0 Manual - Block-Based programming  

To begin programming the RGB example, you must ensure your program runs continuously. To achieve 

this, you will add an infinite loop to your code. Next, you can find the specific block for the RGB bar 

under the 'Hardware' tab in UiFlow. For each color, you will use the corresponding color from the 

sliders.
4 Click on the Event blocks - 

select loop block

5 Drag it into the coding 

area and connect it to the 

setup block

6 Expand Hardware tap

8 Drag it into the coding 

area and connect it to the 

Loop block

7 Click on the RGB blocks - select 

Set RGB Bar Color block



Once you have finished, you can click on the 'Run' button located in the bottom right-hand corner of the screen. From there, adjust 

the R, G, and B sliders to select your preferred color.

RGB Color  - LET’s move MC4.0 kit MC4.0 Manual - Block-Based programming  

9 Click on the Slider blocks - 

select label Get block

10 Drag it into the coding 

area and connect it to the 

Set RGB Bar block

11 change the Sliders name 

according to the each color

R > slider0
G > slider1
B > slider2

3 LET’s move MC4.0 kit

The MC4.0 kit comes equipped with mecanum wheels, which are special wheels that allow for omnidirectional movement. Mecanum wheels 

have a unique design of angled rollers that enable the wheel to move in any direction, including sideways and diagonally. This makes the 

MC4.0 kit is highly maneuverable and versatile, as it can easily navigate around obstacles and change directions on the fly. In the next, we'll take 

a closer look at the movement capabilities of the mecanum wheels and explore how they allow the MC4.0 to move in any direction. Then, we'll 

delve into the programming side of things and see how we can control the movement of the MC4.0 with UiFlow.

When all the mecanum wheels 
on the MC4.0 are moving in 
the same direction, it will 
move  e i ther  fo rward  or 
backward.

when two of the side wheels 
move in the same direction the 
MC4.0 kit will move in a 
s ta t ionary  c lockwise  o r 
anti-clockwise direction 

If two of the side wheels move 
in the same direction while the 
other two move in the opposite 
direction, the MC4.0 kit will 
rotate in a stationary clockwise
 or anti-clockwise direction.



Now that we understand the basics of the mecanum wheels and how they work, let's dive into programming the MC4.0 kit to move 

using block-based programming and UiFlow. here we'll explore how to use the specific blocks for motor control, how to set the motor 

speed and direction, and how to combine these blocks to make the MC4.0 move in different directions and patterns.

LET’s move MC4.0 kit MC4.0 Manual - Block-Based programming  

When two of the wheels move anti-clockwise and the other two move 
clockwise, the MC4.0 kit moves in a sideways direction 

To Right To Le�

When move two diagonal wheels in the same direction , the MC4.0 kit 
will move diagonally along that axis 

by rotating the front left wheel 
in the opposite direction of the 
front right wheel while keeping 
the back wheels stopped, the 
MC4.0 will move in a circular 
path.  This is because the 
mecanum wheels are designed 
to allow for omnidirectional 
movement, and by rotating the 
f r o n t  w h e e l s  i n  o p p o s i t e 
d i r e c t i o n s ,  y o u  c r e a t e  a 
sideways force that causes the 
MC4.0 to move in a circular path.

Let’s get Started! 

1 Add Loop block into Setup block

as we did earlier 

2 Click on the MC4.0 blocks under Third

Party tab 

3
Select the desired block to 

program the movement of 

the car.



Congratulations on reaching the programming section of the MC4.0 manual! It's time to write your first example and make the car 

move in a specific direction using block-based programming with UiFlow. This will be an exciting moment because you'll see your 

MC4.0 car come to life as you program it to move.

LET’s move MC4.0 kit MC4.0 Manual - Block-Based programming  

4 Click on the Timer blocks and chose wait 

option, increase the time as wanted 

This program will allow the MC4.0 kit to move forward for 1.5 seconds, then move towards the right sidewalk for 1.5 seconds, 

then move backward for 1.5 seconds, and finally move towards the left sidewalk for the same duration of time.

Let’s test other way to control MC4.0 kit

5 Motor Number

6 Motor Direction

7 Motor Speed

Motor Number Motor Location Motor Direction Motor Speed

1

2

3

4

Left rear

Left front

Right rear

Right front

0  >>    Forward

1  >>  Backward

0  >>    Forward

1  >>  Backward

0  >> Backward

1    >>  Forward

0  >> Backward

1    >>  Forward

0%     to    100%

This program will make the MC4.0 move forward for 

a duration of 2 seconds and then come to a stop.

However, if you want to have more control over the 

motor movement, you can use the individual motor 

blocks. These blocks allow you to specify the speed 

and direction of each motor separately. To use these 

blocks, you will need to enter data into the table below, 

which specifies the speed and direction for each motor



The MC4.0 kit comes with an ultrasonic sensor and a line-follower sensor, both of which can be easily controlled through the 

block-based programming language. The ultrasonic sensor is equipped with RGB eyes that allow it to detect objects and measure 

distances. The line-follower sensor, on the other hand, is designed to detect different colors and is especially useful in following 

lines or navigating through paths with color-coded markers.

Ultrasonic & Line-Follower sensors MC4.0 Manual - Block-Based programming  

2 Ultrasonic & Line-Follower sensors

1
With this block, you can read the ultrasonic value in CM, The number in the block indicates the 

port to which the ultrasonic sensor is connected. You can refer to the port schedule below to 

determine the correct port.

Port Name Pin number

Port A

Port Name

32 Port B

Pin number Port Name

26 Port C

Pin number

14

2

This block can be used to control the RGB eyes of the ultrasonic. The first 

parameter specifies the eye number, which is 1 for the left eye, 2 for the right 

eye, or 3 for both. The last three parameters determine the color of the eyes, 

with values ranging from 0 to 255 for red ®, green (G), and blue (B).

3

This block to read the data from line-follower sensor, The 

first parameter is for the specific point or dot number on the 

sensor that you want to read from, as the sensor consists 

of 4 points. The second parameter is for the port that the 

sensor is connected to, and you can refer to the same port schedule as before. Finally, the last parameter allows you to choose the type of detection you want the 

sensor to perform, whether it's digital, analog, or color.

Let’s try the examples of these two sensors

Line Follower example

Obstacle avoider example



it's time to take your programming skills to the next level and dive into the world of script programming. With this powerful 
tool, you can create more complex programs, add more functionality to your kit, and take full advantage of the capabilities 
of the sensors and modules available to you. In this section, we'll explore the basics of script programming for the MC4.0 

Script programming (Python and C++)
Get ready to take your coding skills to the next level

1 Python

In UiFlow, transitioning from block-based programming to Python script programming is as easy 

as clicking a button. This makes creating your first "Hello World" program in Python a breeze. 

As we mentioned earlier, the "Hello World" program is the cornerstone of programming, 

Hello World

kit and show you how to write your first scripts to control the kit in new and exciting ways.

After creating your "Hello World" program in block-based programming, you can easily convert it to Python using the button in 

UiFlow. This allows you to see the Python code that corresponds to the blocks you used.

From there, you can continue to learn and explore more advanced concepts in Python programming. With our platform's simple 

and user-friendly interface, you'll be on your way to becoming a skilled Python programmer in no time.

one click to switch between Blockly and Python



Once you have loaded and selected an image, you can easily switch to Python code and notice how to initialize the photo within 

the MC4.0 controller using Python.

Load Image in Python - RGB Color MC4.0 Manual - Script programming (Python and C++)  

1.1 Load Image in Python

initialize an image with 

If you want to select a different image from the ones that are already loaded, you can use the following function:

image0.set_img_src( )"res/MC4.0 Logo.png"

image0: as an object defined from the previous line
the function to call an image is : set_img_src
one parameter here refer to the name of the image

1.2 RGB Color in Python

As long as you have completed the previous RGB example using block-based programming, you can easily convert the code into 

Python script programming to further understand the difference. By switching to Python, you can edit the code and add more 

functionality to the program



Script programming in Python offers more flexibility and control compared to block-based programming. With Python, you have 

the ability to write custom code and manipulate variables directly, giving you more precise control over your project.

RGB Color - LET’s move MC4.0 kit using Python MC4.0 Manual - Script programming (Python and C++)  

1.3 LET’s move MC4.0 kit using Python

In this section, we will delve into the functions responsible for controlling the movement of the MC4.0 kit, including how to control 

each motor, adjust motor speeds, and read encoder values, in addition, to obtaining ultrasonic data, changing the color of the MC4.0 

eyes, and obtain line follower values.

robo = Robocar() This is needed object to run all possible functions 

Python script Block

robo.set_motor_speed( , , )1 1 50

robo.set_motor_angle( , )45 0

robo.motor_stop( )1

robo.move_forward( )50

robo.move_backward( )50

robo.move_right( )50

robo.move_left( )50

robo.rotate_right( )50

robo.rotate_left( )50



LET’s move MC4.0 kit using Python - Arduino IDE MC4.0 Manual - Script programming (Python and C++)  

Python script Block

robo.clear_encoder_count( )1

robo.read_encoder_count( )1

robo.distance_sensor( )14

robo.rgb_ledshow( , , , )1 50 50 50

robo.multi_line_sensor( , )[ ]26 1 0

Follow our learning platform on our website to access a wealth of knowledge and prepare yourself for your
Python journey
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2 Arduino IDE

Welcome to the world of MC4.0! In this section, we will introduce you to the Arduino IDE compatible. You will learn how to write, 

compile, and upload programs to your kit, and get hands-on experience with a few basic projects. Whether you're a beginner or an 

experienced programmer, this section will provide you with the knowledge you need to get started with MC4.0 programming in 

Arduino IDE. So, let's dive in and explore the endless possibilities!

 IDE



Before starting this installation procedure, you need to have Arduino IDE installed on your computer.

 There are two versions of the Arduino IDE you can install: version 1 and version 2.

Install MC4.0 Board to Arduino IDE MC4.0 Manual - Script programming (Python and C++)  

2.1 Install MC4.0 Board to Arduino IDE

You can download and install Arduino IDE by clicking on the following link:

Arduino IDE

To install the MC4.0 board in your Arduino IDE, follow these next instructions:

1. from the file menu choose Preferences , then in Preferences dialog box enter the 

following into the “Additional Board Manager URLs” field:

https://makerandcoder.com/downloads/Arduino_IDE/MakerAndCoder_index.json

Or scan the QR code to copy the link



2. Open the Boards Manager. Go to Tools > Board > Boards Manager

Install MC4.0 Board to Arduino IDE - Install required libraries MC4.0 Manual - Script programming (Python and C++)  

3. Search for and press  button for the “Maker & Coder”:MC4.0 install

2.2 Install required libraries

Open Libraries Manager from Sketch > Include Library > Manage Libraries 



Search for M5Core2 and press  button for the “M5Stack”: install

Install required libraries MC4.0 Manual - Script programming (Python and C++)  

From the pop-up box click on INSTALL ALL



Plug the MC4.0 Controller to your computer. With your Arduino IDE open, follow these steps:

1. Select your Controller from  Tools > Board menu > Maker & Coder > MC4.0 

Testing the Installation MC4.0 Manual - Script programming (Python and C++)  

2.3 Testing the Installation

2. From the Tools menu, Select the Port (if you don’t see the COM Port in your Arduino IDE, you need to install the MC4.0 Driver

3. To install the USB driver for MC4.0:

LinuxMacOSWindows



3. Open the following example under File > Examples > M5Core2 > games > floppybird 

Testing the Installation MC4.0 Manual - Script programming (Python and C++)  

Hello World

Enjoy playing Flappy bird game ^_^

2.4 Let’s Move MC4.0 kit with Arduino

In this example, we'll show you how to control the MC4.0 kit using the Arduino IDE. 

To start, we'll need to include the required libraries and files. We'll be using three 

files: two for the motor drivers and one for the MC4.0 image to be displayed on the 

screen. In the setup function, we'll initialize the MC4.0 and the screen. Then, we'll 

move the kit in a specific sequence, with 1.5 seconds for each movement: left, right, 

forward, backward, and some diagonal directions.
Scan for Arduino IDE example 



Firmware is a type of software that is installed on a hardware device, such as the MC4.0 kit, and provides low-level control of the 

device's functions. It is typically designed to control the behavior of the hardware, manage interactions with other devices, and 

provide a stable platform for the software applications that run on the device. Firmware is often pre-installed on devices, but 

can also be updated or replaced to improve functionality or fix issues.

Testing the Installation MC4.0 Manual - Script programming (Python and C++)  

2.5 Download Firmware

2. Next, connect your MC4.0 kit to your computer using a USB cable. 

1. First, download the latest firmware version from the official Maker & Coder website. You can find it 

under the "References" section of the MC4.0 product page or find this URL:

To install the firmware on the MC4.0 kit, you'll need to follow these steps:

It's important to note that if you're switching from the Arduino platform back to UIFlow, you'll need to reinstall 
the firmware on the kit. This is because the firmware is different for each platform, and switching between 
them requires a firmware update.

https://makerandcoder.com/downloads/Software/MC4.0%20Firmware.exe

MC4.0 Firmware3. Once the firmware burning tool is downloaded, open it and select the right COM port for your 

MC4.0 kit. You can find the COM port information in the Device Manager on your computer.

4. After selecting the correct COM port, click on the "Burn" button to 

start the firmware installation process. You'll see a progress bar that 

shows you the percentage of completion.

6. Once the firmware installation is complete, the MC4.0 kit will 

automatically restart and return to its initial status.

5. During the firmware installation process, a command prompt 

window will pop up. This is normal and it's part of the installation 

process. Don't close this window until the firmware installation is 

complete.



After - SALES SERVICES AND TECHNICAL SUPPORT 
If you come across any issues with the quality of the product or
discover any missing or damaged parts upon opening the
package, or if you require any technical support, please reach
out to us for after-sales assistance via the following contact
information:

Support@makerandcoder.com

(Service Hour: 9:00-17:00 (+4 GMT) from Monday to Friday) 

www.makerandcoder.com
Designed & Marketed: Maker and Coder
Address: 105, 1st floor, The Atrium Centre, Bank Street, Burdubai-Dubai
UAE 124467
Phone: +971 4  318 0283
What's App: +971 56 398 2854
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